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IBE sede di Bologna - Consiglio Nazionale delle Ricerche (CNR)

Gruppo di Fitorimedio e mitigazione ambientale di Bologna

Si occupa, attraverso modelli previsionali che utilizzano misure biometriche e dati climatici, della
caratterizzazione ecofisiologica di specie arboree, arbustive ed erbacee, stimando alcuni dei piu
importanti servizi e/o disservizi ecosistemici che gli alberi svolgono durante la loro vita biologica: il
sequestro d al | 0 at diouno der principali gas serra, | 0 a n | darbbrdca (CO,), il suo successivo
Immagazzinamento nella biomassa, la produzione di ossigeno (O,), la rimozione di alcuni importanti
inquinanti atmosferici come | 6 o z Og)oil biossido di azoto (NO,) e di zolfo (SO,) e il particolato
atmosferico (PM10 e PM2,5), lariduzione del ruscellamento delle acque piovaneel 0 e mi sd sostanee
organiche volatili (VOC)
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Map 9.1 Concentration interpolated maps of (a) PM,, (annual mean, pg/m?), (b) PM, s (annual

mean, pg/md), (c) 0; (SOMO35, pg/m3days) and (d) NO, (annual mean, pg/m?) for 2018 (cont.)

b)
Concentrations of fine particulate matter (PM2.5)

Atmospheric CO; at Mauna Loa Observatory
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Le citta sono le principali protagoniste dei cambiamenti
climatici:
nonostante coprano il 2% della superficie terrestre, sono
responsabili

Nel 2021 almeno 253.000 persone sono morte prematuramenten e | |
acausadel | 6 e s paolshgmanente da PM,s a livelli superiori ai
5 pg/m3 menzionati nelle linee guidad e | | 6 SanhbSnvece 52.000 quelli
causati da NO, e 22.000 per ozono

L 61 t A klasaifica al terzo posto in Europa per numero di morti
causati dal | 6i nqguicom B®64lt decessi prematuri, dietro
soltanto a Francia e Germania.

(rapporto European Environmental Agency))
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rBteU Eﬂkey is not included in the map of annual average PM, ;, because there was large uncertainty in the modelling results due to the lack of
ata from rural background stations in the country.

Lo OMiBnachel 6 esposail £D0negucausiar
livello mondiale 7 milioni di morti premature all'anno
(25% delle malattie e della mortalita globali)



Servizi ecosistemici delle piante

Le piante, attraverso i loro processi fisiologici, ci forniscono diversi servizi ecosistemici:

cMol tepl i ci benef

U Assorbimento della CO, atmosferica :

contribuisce a rallentare il
riscaldamento globale e a
0ssigeno per respirare

fornirci

U Assorbimento inquinanti atmosferici :
mi gliora | a
migliorando la salute e il benessere

U Abbassamento della temperatura :
contribuisce  al raffreddamento
delle nostre citta (stima: il centro
citta potrebbe essere il 50% piu
caldo nel 2050 rispetto al 1990)

U Riduzione del ruscellamento delle acque piovane
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Urban forest ecosystem services at different scales (Livesley et al., 2016)



Servizi e disservizi delle piante:fitorimedio

1) Assorbimentodella CQ ed emissionedi ossigeno(O,) 2) Assorblmentodl inquinanti atmosferici
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. RESPIRAZIONE FOTOSINTESI

—»- respirazione —- fotosintesi O, = ossigeno CO, = anidride carbonica

3) AbbassamentadellatemperaturaR St £ QI N& |

Isola di calore urbana
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B. Hydrophilic
and/or low
molecular
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gaseous
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high molecular
weight gaseous
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2024

" _ (m Climate
- Gp'rernlcl'rjs } Change Service

A livello mondiale il 2024 é stato I'anno piu caldo della
serie storica disponibile. Ma in Italia? E' stato lo
stesso, ma con un aumento almeno doppio di quello
mondiale rispetto all'epoca preindustriale.

() OOO) ANNUAL MEAN TEMPERATURE
Y NC_ND
! ! year-to-date value . !
« ] positive anomalies (relative to 1991-2020 mean) =
2 r H negative anomalies (relative to 1991-2020 mean) wmm | 5
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3) Abbassamento della temperaturad e | | par i 4
ormbreggiamento ed evapotraspirazione Riduzione dal 5 al 28% dei decessi estivi per

o il caldo raddoppiando gli spazi verdi(da 15 a
Ri duzi one Un albero j ‘gspgazione 33%) in citta (Melbourne)

. traspira
di calore urbano fino a 450 — o
llt” dl Environmental Pollution wﬁom
H 20 s journal homepage: weww.elsevier.com/locate/envpol
al giorno ombreggiamento |

m_' - = Urban vegetation for reducing heat related mortality @C"h_\m
4 i Dong Chen ™, Xiaoming Wang*, Marcus Thatcher ", Guy Barnett”, Anthony Kachenko®,
((( ))) Robert Prince
A La traspirazione e un processo ool i gy o e ekt ek e

g ‘ S0 Cliste Adeptotion Hagi and CSIT) Msrine s Amenpherc Rrseseth, Melbourme, Antraba
1om endotermico: per ogni grammo H,0 | 77T
evaporata si consumano circa 633

cal (1000 MJ)

Distanza di
influenza a terra

Riduzione della mortalita da calore in aree
urbane con maggiori spazi verdi (Seul, Corea)

Green spaces’ cooling effect

: Fino a 10 m per gli arbusti, fino
Minore temperatura 60 m per le piante EFFETTO

Maggiore umidita relative. RAFERESCANTE
Filipa Grilo et al, Sci. Tot. Env. 2020, modificata DEL VERDE

Comincs lists available at Sciencelineo

Environmental Research .
journal homepage: waw.elsevier.com/locatefenvres

Urban vegetation and heat-related mortality in Seoul, Korea @,,n
J-¥oung Son !, Kevin | Lane”, Jong-Tae Lee ", Michelle L. Bell **

* Seiwal of Forniry br Eradraarsrmial S, Tabr Vi, U 164
* Depormmeet of Eainbnmenial Mook, Colige of Health Some. oav Unkerrity, Seoil Repablc of K

In aree con maggiori verde residenziale diminuiscono i rischi perjla
popolazione di decessi estivi per il caldo e per cause respiratorig e
cardiovascolari

Gascom et al- Environment International, January 2016 RojasRueda et al- www.thelancet.com/planetary-health,
2019



Isoprene
Monoterpeni

+ altri VOCs

< 5% della CO,
assimilata

Legno foglle suolo
> 95 % della CO,
assimilata

no't o, .he .una
dalle foreste viene destinata alla produzmne
del Compostl Organici Volatili (COV),:

métaa b ol 't i ¥siecofidar®




INDICE = OFP: POTENZIALE DI
FORMAZI'ONE 'DELLOOZONO

OFPspecie: B*[(Eiss*Rico) T (Ermono™Rmono)]

B=BIOMASSA FOGLIARE E=TASSO DI EMISSIONE
R=REATTI VI TA6composti emessi

Tabella 33. Alberi e arbusti ornamentali distint in base al loro potenziale di ozono-formazione (POF)

Potenziale di ozono-formazione, g O, planta’ giorme

< | < 10 = 10
Acer negundo Abies comcolor Eucalypius glotrults
Arbutus umedo Ceratonia siligun Liguidambar styraciflua
Cupressis semervireTs Lirtodendron tulipifera W
Juriperus eccidentalis m Phoenix dactilifera
Lagerstrocmia mdica Myrtus commrurnis Preea atnies

In ambiente urbano € importante usare specie con basso POF per la

mi tigazione dell 6ari a
Pirrus pineo Peevudotsuga menziesii Cercus suber
Pittosperum tobira (Quercus rulbrg Salix balvipnica
Robinia psewdo-aoacia SEquotE SEmPeTVIngHs Warshimgronia robusta
N -

Le specie sona elencate in ordine alfabetico,
{Dati i Benjamin ef al, 19596)

Tratto da: ALe piante e | édinquinamento dell daria. G. Lorenzin



Leafstr

Nervatura il

inferiore

Lamina o pagina
superiore

& Cuticola

La cuticola é ricoperta da
cere idrorepellenti

Gli stomi scambiano 0O WS
CQ,HOLGa B’ & DDGS5 5 naval

Ognispecievegetalepossiedeuna
propria capacita di mitigazione
ambientale che dipende sia da
fattori Intrinseci  (fisiologia,
morfologia,dinamichedi sviluppo)
cheestrinseci(numerosita)



MODELLI ECOFISIOLOGICI

>

Utilizzo di Software per la stima del beﬁfici ecosistemici propedeu
per simulazioni e valutazio la rigenerazione urbana




STRUMENTI MODELLISTICI PER
LA VALUTAZIONE AMBIENTALE
DELLA VEGETAZIONE ANCHE
PER LA PIANIFICAZIONE
URBANISTICA
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E6 un modell o di cal col
gratuito che quantifica i benefici prodotti dal
verde (alberi e arbusti) dal punto di vista
ambientale ed economico.

i-Iree

INNOVATIVO E
Tools for Assessing and Managing SCIENTIFICAMENTE
Forests & Community Trees VALIDATO

I- Tree Eco: strumento flagship che
g puo essere utilizzato per valutare
un inventario di alberi esistente o
una nuova raccolta di dati
biometrici sul campo per ricavare
stime dei benefici dei singoli alberi

&

I

i-Iree i-Iree
\ Landscape / Canopy Design {:}

i-Iree.

Streets Hydro
T i [SA . EF Aol —  Structure == Function == Benefits |
MU G ———————— - — s



Modello ecofiSiologICo: dat I e

Attraverso l'applicazione di modelli € possibile quantificare
| benefici ambientali ed economici del verde urbano

Il software effettua stime combinando
Species data
Input minimi

Nome della specie
diametro del

Location Data [

tronco
Numero degli
alberi

Location data

A Dati meteorologici
(temperatura e piovosita)

A DatiQualitad e | | (®aNQ,,a
SO,, PM10, PM2.5)

United States Department of Agriculture - USDA

i-Tree stima

A Sequestro annuale e immagazzinamento della CO,
Assorbimento O, NO,, SO,, PM10 and PM2,5
Emissione di O,

A Emissione di vOC
Ruscellamento delle acque piovane
Risparmio energetico ed economico



Le specie possono avere |lo stesso diametro ma possono essere molto diverse nella:

1) Biomassa

2) ombreggiamento

3) Intercettazione degli inquinanti
4) Area fogliare

5) Pioggia intercettata dalla chioma
6) Capacita di traspirazione e riduzione della temperature relativa

| BENEFIT AMBIENTALI variano in funzione
di:

1) DECIDUE o SEMPREVERDI

2) LATIFOGLIE o CONIFERE

3) TOLLERANTI ALLO STRESS IDRICO
4) TASSI DI CRESCITA e DIMENSIONI
5) LONGEVI TAOG




Specie

Esposizione alla luce

Esposizione
alla luce

Dati biometrici

exposicon 2 0 3 1

Altura Altura Altura
Total Total Total
Exposicion | U IR sy [ R e 1
Base Base Base
de Copa de Copa de Copa
% di chioma
manc ante 10% Dosel Faltante 0% Dosel Faltante

- -

Altura Altura
Total Total

Altura
Tota[ Exposicién 5 2 5

Base Base
de Copa

Base
de Copa

40% Dosel Faltante

30% Dosel Faltante 15% Dosel Faltante



i-Tree Eco v6.0.32

LOUSO

Project Configuration Datz View Reports Forecast Support
- r ) @] ;\3
S - | 8 % 0 y @ File > New Project = {0 x
User  User Tree  Video User iTree Software About License Feedback What's Change
Manual Guides - Methods Learning Forum Website Update Agreement &Bugs =~ New Log Enter proje jew information and click OK to save it or Cancel to quit this proce: B % i
Project Setting Data Collection Options ¢
CO: Yes
Help 1 . use W ieur o serccuun. Mirandala
i 1 03: Yes
To get started, go to the File menu and select one of the Welcome to i-Tree Eco! Not all cities for intern_ational Ic:oations are available due to limitations of information provided by coog 02 “
fol | . these cases. For more information, please see https://datsbase.itreetools.org/#/viablelocations & €s:
i-Tree Eco is a software appl e S02:
lots throughout a study are . ol .
P e : i Nation: Italy | Please check adjacent Cou oy i e, Yes
pen Project — 1o open an existing Eco project. structure, environmental effi : Bologna, Nord-Est,  lgiore Cor
. . locations that may straddl Nonantola rsy ologna;Nor-ES
Open Example Project —to open and explore State: Nord-Est - < Location: ttal
an example project provided by Eco. : under Delaware county, althe od'ena\ el
If you are new to Eco, pleast N Station ID: 0021 | S
) ) County: Bologna [Province) v Castelfranco ) \
Choose from the available tabs at the top of the ribbon . e Emilia Distance (km): 0.0 1
bar to access the different phases of an Eco project. 1_ ree If you have used previous ve City Bologna ~
Within eaE?_’w tab, you can click on one of the functions w the ribbon above. SRambety S 7 / Afoing
or buttﬂﬂ% inthe rlbbﬂﬂrﬁbDVE: The featt} re that you e Is the study area Urhan? vignola )"3 Medicina | %
choose will become available in the action panel to the Eco N l\ N
right. If you wish to resume work ¢ Population: ‘392000 | ©zzano dellEmilia 4 .
H o | Castel San. WR
1anoro Pietro Terme.
. . Guidance is provided in the | Population per km?: ‘2800 | ol
For more information: . i
https//www.itreetools org/support/resources- information. Note: Pracioitati lues % \/
overview/i-tree-manuals-workbooks Please specify the following years for your project: ote: ) recipitation values o > &
4T
i S Forli
Weather & Pollution Year: | 2019 (Weather and Pollution) ~ | | Show Pollution Stations / Forlimpe

Project Settings  Locatio
‘What units will you be using during your data collection?
O English ﬂ This option cannot be changed once a project

has been created.
® Metric

TREE INFORMATION

Minimpum Requirements
JEpeues
w DBH

General Site Fields
[] Tree address
[J Land Use
[] strata/Area
= Check this box if you know
'your project area.
= SeeProject & Strata Area

to configure description and
area,

[ status
[ street tree/nan-street tree

Measured ~

Default non-street tree
[ Map (GPS) coordinates
[ Public/private

Default Public v

Please select a weather station to use for your project:

Weather Station:

[1c2:c0 200- I

Show Map

®  These fields MUST be collected!

®  These fields are optional and HIGHLY RECOMMENDED to improve model
estimations.

™ These fields are optional.

Tree il Fields Management Fields

Total tree height [] Maintenance recommended
[J Maintenance task
[ sidewalk conflict
[ utility conflict
[ Pests (IPED)
(requires 5 fields for each of

Crown size

= Height to live top

= Height to crown base
+ Crown width

+ Percent crown missing
Crown Health

the following)
O Dieback = Sign & symptoms of tree
(® Condition stress
= Sign & symptoms of
Crown light exposure foliage/twigs
0o Energy (building + Sign & symptoms of
interactions) branches/bole

+ Distance to building
= Direction to building

[ User Tree ID
(Can be used to track custom
tree D)

Mal Location Distance Radius
« Smiles
o « 10mies
igo Adria osClg . 25miles
5] Weather Station Icons
Rarco del
Suzzar  Pposition (lat, lor Beleigeln salacia
| Collection Completeness: S0la dAriano 2
. Guastalla ge¢ Annual Precipitation Sade . Good Completeness
Donzel ®
U [ ssa0s ] Fair Completeness
o Novellar:
Codigoro Poor Completeness
Parma
Zoom to Selected Station
Somarchiy Zoom to Project Location
Rubl A
L —— ——c—
anghirano Shisaky Argenta =0
Coling romane o
Reggiana’ sofu
el oY
Vignola. Mar
Castelnovo) Castel Guelfo =
ne’ Monti \ di Bologna / Lugo Ravenia
2 Imola /2
Pavul\n\Nel Sse7
2 Frignand, =
% Faenza
g m e
Brisighella Foi
Forlimpopoli Cesenatico
Castelnuovo # Meldola  Cesena A .
aSnEs sul Rubicone mm, é‘f ‘
9 () & Parco Riccione
fl Borgo San Nazionale Cattolica ‘
Pistoia Lorenzo dellejForeste S
i
o 2 Casentinesi.. \
areggio Terme. rato “ el —
Lucca Capi gnod)
o0 Le7e Bisenzio! Fiesole 9" !



Project Configuration

Data View Reparts Farecast Support
EH B T MRS E&f
Submit  Retrieve Paper | Import | Trees Check | Benefit §nnual | DBH Crown | €
to Mobile from Mobie | Form Data Prices JCosts Health
Data Collaction Inventory DataQ Inventor Value | Report Classes

>

Data > Inventory Value > Benefit Prices
> Inventory Value > Benefit Prices

- Eco calculates the monetary value associated AdeSt your Benefit Prices tadvan*d u““]
‘he ecosystem services (e.g., carbon storage)
ded by the trees, shrubs and grasses in your

Notes:
« The Default values are those available at the time of software installation.

Project Configuration

Datg Reports  Forecast  Support

B 5O 8 &

Submit  Retrieve | Paper | Import | Trees (heck | Benefit Annual| DBH Crown | C

to Mobile from Mobile | Form Prices Costs Health
Data Collection Data! Inventory Value| Report Classes

area. = [f you leave a voiue blank, the most current defouit value will be used for processing and disp
= Alternatively, you may enter your own vaiues if you know them.
= Far future reference, use the C5V Export button in the ribbon GHOVE 1o SAVE YOUT CUFTENT ValuE

= You may change the vaiues below and update their associated Report sutputs WITHOUT resul

enefit Prices function seen in the action panel
- right provides advanced users with the
rtunity to adjust the default benefit prices that
sed by the model. Please use this function with
an!

Measurement Units: Metric

Benefit Prices
dy submitted your project to the Eco server Electricity (€ (EUR]/kwh)
etrieved your results? No problem — this form
e edited at any time and you will not be

red to submit your project again. Results on
aports tab will reflect the change in valuation
diately.

Heating (€ (EUR)/therm)
Carbon (€ (EUR)/metric ton)

Avoided Runoff (€ (EUR)/m?)

fine your benefit prices, do one of the

ving for each benefit price:

Jick on the Default button to use the defaults
vailable with this version of Eco;

eave the space blank to use the most current
efault values; or

Aanually enter the benefit prices that you

For any prices left blank or not shown here the latest default values will be used. These values will be [j

Acurrency exchange rate is needed to convert som

Currency Exchange Rate: 1.00 US Dollar = € (EUR)

1
I

DBH 1:
Height (m)

DBH 1:
Measured?

Survey Date Species Photo ID DBH 1 (cm) DBH 2 (cm) B:;P?t:(m)

Black ash (Fr... 24

]

Forecast Support

S T O L X

nefit Annual | DBH Crown | CSV KML | Mew Undo Redo Restore Delete Editing
031701 Get today's rate ices Costs Health Defaults Mode: On
tory Datal Iffentory Value | Report Classes Export Actions

Data > Inventory Data > Trees

Required inputs MUST be completely and properly filled out. If you get stuck, you can delete the row and start over.

ve
DBH 6: DBH 6: Crown: Total Width
Height (m) Measured? Condition Height (m) N/S (m)
longer on m
symbols
=d ) .
sop of the Valldatlng Data ...
i-Tree Eco
go here:
198&t= All of your data appears to be free of errors and ready to be Submitted
for Processing.
Support
Individual

Project Configuration Data View Reports Forecast
Project| Submit Data Track & Written  Composition Benefits
Metadatd for Processing Fetrieve Results | Report and Structure - and Costs - Level Results .
Formatted Re

ports

18



Esempio di output di i-Tree eco

Composition and Structure of Individual Trees

Location: Alessandria, Alessandria, Nord-Owvest, Italy
Project: IPLA negundo calleryana, Series: 1, Year: 2023
Generated: 24/10/2023

i-Iree

TreeID Species Name | DBH Height Crown Height Crown Width Canopy Cover Tree Condition Leaf Area Leaf Biomass Leaf Arealndex Basal Areg Native to State Date Crew
fcm) _ (m) (m) {m) (m?) (m?) (kg) {m
1 Acer negundo 30,0 13,7 9,5 84 55,2 EXCELLENT 358,5 32,8 6,5 0,071 22/06/2023
2 Pyrus calleryana 30,0 9,1 6,6 7,6 45,6 EXCELLENT 250,1 18,8 5,5 0,071 22/06/2023
Total 100,7 608,6 51,6 0,141

Pollution Removal by Individual Trees

Location: Alessandria, Alessandria, Nord-Ovest,
Project: IPLA negundo calleryana, Series: 1, Yea
Generated: 24/10/2023

Italy
r: 2023

Tree ID Species Name Pollution Removed (g/yr)
co 03 NO2 SO2 PM10* PM2.5
1 Acernegundo  |0,0 515.079,8 837714 00 766 159
2 Pyrus calleryana | 0,0 359.311,5 584376 0,0 53,4 11,1
Total 0,0 874.391,3 1422090 00 1300 27,0
Benefits and Costs Summary of Individual Trees s
Location: Alessandria, Alessandria, Nord-Ovest, Italy
Project: IPLA negundo calleryana, Series: 1, Year: 2023
Generated: 24/10/2023
Annual benefits
Gross Carbon B Energy | Total Annual
Tree ID Species Name  DBH Replacement Value| Carbon Storage | Sequestratior] Awvoided Runoff Carbon Avoided | Pollution Removal | Savings | Benefits
{cm) (€) (kg)  (€) |(kgfyr) (Efyr) (m/yr) (€fyr) (kgfyr) (€/yr) | (gfyr)  (€fyr) | (€/yr) (Efyr)
1 Acer negundo 30,0 1.132,11 1846 295,67 64 4,2 05 098 M/A N/A SIRTHERT 390701 MNfA 3.952,23
2 Pyrus calleryana 30,0 1.695,28 2234 35,89 270 4,34 04 068 M/A NfA 417.813,7 2.753,37 M/A 2.758,39
Total 2.827 408 66 53 9 1 2 N/A N/A 1.016.757 6.700 N/A 6.711

i-Iree



I-lree implementazione Studi portati avanti da diversi

Le ricerche svolte presso I'IBENR di Bologna hanno
permesso di quantificare i benefici delle singole specie
comunemente piantate nella Pianura Padana.

anni sia nell'ambito di progetti
europei (Life Gaia) che in
collaborazionecon associazioni
nazionalidel vivaisti

PlantaRegina




LE 46 SPECIE DI

» Acer platanoides

+ Acer campestre*

» Acer pseudoplatanus

» Acer monspessulanum®

» Albizia julibrissin*

Alnus glutinosa*

» Betula pendula

» Carpinus betulus
» Catalpa bungei*
» Celtis australis*

» Cercis siliguastrum*

» Crataegus monogyna®*

» Flaeagnus angustifolia

» Fraxinus excelsior

» Fraxinus ornus®

-

)
o

] VG

» llex aquifolium

» Ginkgo biloba*

» Koelreuteria paniculata*
» Gleditsia triacanthos

» Liguidambar styraciflua
» Laurus nobilis
» Ligustrum japonicum®*

» Liriodrendon tulipifera

» Magnolia grandiflora
» Malus domestica
» Malus floribunda
» Morus alba pendula*

» Ostrya carpinifolia
» Parrotia persica®*

Parrotia persica*
Pawlonia tomentosa*
Photinia fraseri*
Platanus x acerifolia
Populus alba

Prunus avium

Prunus lusitanica
Quercus cerris
Quercus pubescens
Robinia pseudoacacia
Salix alba

Sambucus nigra*
Sophora japonica

Tilia cordata

Tilia plathyphyllos
Ulmus minor

Viburnum tinus



Sotto-progetto di

Acer pseudoplatanus L. : Mx/am

T e e T | informazione-
e = 'A‘?efo'd‘m"’?ntef””f‘"'.f”“f' divulgazione:
e N\ B SR JE banca dati di

el SELCERE N schede innovative
qmaxgne@emaho . : ) ; X g b i

e Www.vivam.it
e https://www.facebook.com/VIVAIGAL
Rapidita di sviluppo media

bR ol S iR
Fioritnnapn’le-maggio

Caratteristiche

Ahgeuedltempenhul Q[Iedﬂ
_ Bassa allergenicit © $

morfo
fisiologiche

B

. Una pianta di30 cmdi . . .

y ' ﬁl;o;u. °.Plciﬂ dl R ; diame-txo di ‘o;ero di mc‘nte..
] \amb]ent‘ .,n,; ho ; ~~ | Sequestra annualmente 82
<. % esuburbang ¢ ); - - ¥8.d1CO;z ed ha accumulate

. 772kgdi co;

- Rilascia 60 kg di osszgeno
.~ ﬂllma AR, .

16 piante di scero di monte assorbono’
Tequivalente della CO; emessa da un'auto di
media ¢ilindrata che percorre 10.000 knm/anno
€ ;
1 pmnts assorbe l’equn alente dell'emissione di
pa:rhcolato della stessa auto -

Servizi

* Assorbe annualmente:
L. 6,5gdiPM25 |
B NDG o st e
. 222502
® .. 375g0;

ecosistemici

" | Emette 170 gdiCOV' =~
. all’anno, in particolare
. monotezpem

*eme - Coatribuisce alla riduzione -
B’Eh " del ruscellamento

= | superficiale di 0.3 m*

. all'anno .

‘. Populus alba L. |/, o

Pioppo bianco

Foglie di forma ovale e di colore
verde con una fitta peluria
biancastra
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Reping Dpartimento di Scienze Bio Agrealmentar
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Una pianta di 30 cm di diametro
di pioppo..

Sequestra annualmente 88
kg di CO, ed ha accumulato
545 kg di CO,

Rilascia 47 kg di ossigeno
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« 7gdiPM25
+ 89 gNO,
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isoprene

Contribuisce alla riduzione
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all'anno

@ Consiglio Nezionale delle Ricerche
Istituto per la BioEconomia



http://www.vivam.it/

Applicazionedel modelloi-Tree Eco al Parco della Resistenza (Asti)

Quercus robul

Magnolia grandiflora  Platanus occidentali 2% (5) _ :
2% (6) 5% (14) Sophora japonice
2% (5)

Libocedrus decurren

255piante o

Taxus baccate -
5% (13)

Ulmus sppUimus sp.

35 species 4% (11) 120
100
Aesculus hyppocastanur
3% (7) 80
Celtis australis o]
51% (130) £ 60
Carpinus betulus 2
2% (5) g 40
"’° =. D
Cedrus atlantica 0

50 (12) PM10  PM2.5 NO2

_ CO €O, O O, | NO, [PM10 |PM2.5| Total pollutants
immagazzinato| sequestrata| emessd
t/pianta t/anno kg/anno

513 23 16 115| 22 30 10 177




Il modello AIRTREE per quantificare la capacita di
rimozione di inquinanti atmosferici dei boschi urbani

S

Silvano Fares AirIree ‘

Consiglio Nazionale delle Ricerche, Istituto peri § ”
Sistemi Agricoli e Forestali del Mediterraneo

Il Team di AIRTREE: T &:

r Consiglio Nazionale
Adriano Conte, llaria Zappitelli, Roberto Corsanici, Luciano Bosso delle Ricerche
)

Alessandro Alivernini, Giorgia Di Domenico, Federico Franchi \" C r e a
‘ Consigfio per la ficerca in agricoltura
¢ lanalisi dell'economia agraria




AIRTREE
multi-layer model

AIRTREE ( Aggregated Interpretation  of the Energy Balance and
Water Dynamics for  Ecosystem Services Assessment)

(XXX

Q2

]
i
K3
!

XX

¥
i
2
8
s

modello multistrato unidimensionale accoppia suolo, piante e processi
atmosferici per prevedere gli scambi di CO », vapore acqueo (H ,0),
ozono troposferico (O ), particolato (PM10 e PM2.5) e biossido di
azoo(NO ,) tra | e foglie e | 6atmosfera
strati per ottenere flussi a livello della chioma. e

Parametrizzazione di AIRTREE: Acquisizione di dati su clima, inquinanti, tratti ,:_\ '/

biometrici ed ecofisiologici k
Airllree
AIRTREE

(Aggregated Interpretation of the Energy balance and water dynamics for Ecosystem services assessment )
Ecosystem services multi layer model

Air Quality monitoring stations (ARPA), EC flux tower (ICOS, Fluxnet)

- INPUT
\ Parametri strutturali (LAI,
altezza, dbh

Scambi gassosi Vcmax, Jmax

Digital hemispherical photography - LAI

Moni toraggio Qualit”™ dell éari

a
Gas Exchange Measurements - Vcmax Structural parameters - dbh, height

r— (ARPA)
. /( Torri flussi EC (ICOS,  Fluxnet) \

Fares, 5., Alivernini, A, Conte, A, & Maggi, F. (2019). Ozone and particle fluxes in
a Mediterranean forest predicted by the AIRTREE model Science of the Tofal
Environment, 682, 494-304.
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Il portale

) WELCOME TO
Come www.alir - tree.eu

AIRTREE

APP MOBILE AIRTREE

funziona

“Aggregated Interpretation of the Energy Balance and Water Dynamics for Ecosystem Services Asses

ecophysiological model estimating greenhouse gas flows and the capacity of forests fo seize air poll
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Sviluppo di un applicativo android



Strumenti modellistici per analisi microclimatic&nviMet

La Modellistica Fluidodinamica come supportenviMet

ENVImet € un modello microclimaticotridimensionalenon idrostatico progettato per simularele interazionisuperficiepianta
aria all'interno dei cicli giornalierinell'ambiente urbano (edifici, giardini e paesaggioxon una risoluzionetipicada 0,5 a 10 m
nello spazioe 10 secnel tempo. E possibilesimularediversevariabili,inclusiil flussointorno e tra gli edifici, i processidi scambio
di caloree vaporeal suoloe alle pareti, gli scambidi turbolenza,i parametridellavegetazionela bioclimatologiae la dispersione
delle particelle (http ://www .envi-met.convy).

Permette la simulazione e quindi la modellizzazionedelle applicazioni per la pianificazione urbanistica, f QI R & ¢
climatico, il comfort e la saluteumana


http://www.envi-met.com/

EnviMet: input e output

INPUT OUTPUT

Areadi Studia

-edificie vegetazione

-usodel suolo Mappe:
-temperaturae umid

Meteo: E NVI _temperaturasuperficiale
-velocita e direzione del -indicibiometeo (PMV, PE

vento; M E T -flussidel vento

-temperatura e umidita -altre
RSt { QF NRA I — - microclimatiche

L'indice di comfort PET (Temperatura equivalente fisiologica), derivato
dal modello del bilancio termico umano, combina parametri
meteorologici e termofisiologici (abbigliamento e attivita umane). Viene
utilizzato per misurare il comfort termico di un individuo in una
determinata situazione confrontando le sue risposte fisiologiche con
guelle che avrebbe nell'ambiente di riferimento, ad esempio un ufficio in
cui si sente generalmente a suo agio.

it&;

variabili




EnviMet: definizione area di studio
»

Sef Q| deBdsserepitl ampia,perchésivuole selezionarainaporzionedi territoria &ﬂo deciderechela cellasiapari a un edificodi dimensionilOm x
10m, in questomodola dimensionedel quadratosaral0m x100celle= 1000m x 100

Y




